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Avaya assumes no liability for any errors. Avaya reserves the right to make changes and corrections to the information in this document
without the obligation to notify any person or organization of such changes.
For full support, please see the complete document, Avaya Support Notices for Hardware Documentation, document number 03–600759.
For full support, please see the complete document, Avaya Support Notices for Software Documentation, document number 03–600758.
To locate this document on our website, simply go to http://www.avaya.com/support and search for the document number in the search box.
Documentation disclaimer
“Documentation” means information published by Avaya in varying mediums which may include product information, operating instructions and
performance specifications that Avaya generally makes available to users of its products. Documentation does not include marketing
materials. Avaya shall not be responsible for any modifications, additions, or deletions to the original published version of documentation
unless such modifications, additions, or deletions were performed by Avaya. End User agrees to indemnify and hold harmless Avaya, Avaya's
agents, servants and employees against all claims, lawsuits, demands and judgments arising out of, or in connection with, subsequent
modifications, additions or deletions to this documentation, to the extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked websites referenced within this site or documentation provided by Avaya.
Avaya is not responsible for the accuracy of any information, statement or content provided on these sites and does not necessarily endorse
the products, services, or information described or offered within them. Avaya does not guarantee that these links will work all the time and has
no control over the availability of the linked pages.
Warranty
Avaya provides a limited warranty on its hardware and Software (“Product(s)”). Refer to your sales agreement to establish the terms of the
limited warranty. In addition, Avaya’s standard warranty language, as well as information regarding support for this Product while under
warranty is available to Avaya customers and other parties through the Avaya Support website: http://support.avaya.com. Please note that if
you acquired the Product(s) from an authorized Avaya Channel Partner outside of the United States and Canada, the warranty is provided to
you by said Avaya Channel Partner and not by Avaya. “Software” means computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products or pre-installed on hardware products, and any upgrades, updates, bug fixes, or modified
versions.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO ARE
APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC., ANY
AVAYA AFFILIATE, OR AN AUTHORIZED AVAYA CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH
AVAYA OR AN AUTHORIZED AVAYA CHANNEL PARTNER. UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING, AVAYA DOES
NOT EXTEND THIS LICENSE IF THE SOFTWARE WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA AFFILIATE OR
AN AVAYA AUTHORIZED AVAYA CHANNEL PARTNER; AVAYA RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU AND
ANYONE ELSE USING OR SELLING THE SOFTWARE WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR USING THE
SOFTWARE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
INSTALLING, DOWNLOADING OR USING THE SOFTWARE (HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU” AND “END
USER”), AGREE TO THESE TERMS AND CONDITIONS AND CREATE A BINDING CONTRACT BETWEEN YOU AND AVAYA INC. OR
THE APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants you a license within the scope of the license types described below, with the exception of Heritage Nortel Software, for which the
scope of the license is detailed below. Where the order documentation does not expressly identify a license type, the applicable license will be
a Designated System License. The applicable number of licenses and units of capacity for which the license is granted will be one (1), unless a
different number of licenses or units of capacity is specified in the documentation or other materials available to you. “Designated Processor”
means a single stand-alone computing device. “Server” means a Designated Processor that hosts a software application to be accessed by
multiple users.
License type(s)
Designated System(s) License (DS). End User may install and use each copy of the Software only on a number of Designated Processors up
to the number indicated in the order. Avaya may require the Designated Processor(s) to be identified in the order by type, serial number,
feature key, location or other specific designation, or to be provided by End User to Avaya through electronic means established by Avaya
specifically for this purpose.
Concurrent User License (CU). End User may install and use the Software on multiple Designated Processors or one or more Servers, so long
as only the licensed number of Units are accessing and using the Software at any given time. A “Unit” means the unit on which Avaya, at its
sole discretion, bases the pricing of its licenses and can be, without limitation, an agent, port or user, an e-mail or voice mail account in the
name of a person or corporate function (e.g., webmaster or helpdesk), or a directory entry in the administrative database utilized by the
Software that permits one user to interface with the Software. Units may be linked to a specific, identified Server.
Database License (DL). End User may install and use each copy of the Software on one Server or on multiple Servers provided that each of
the Servers on which the Software is installed communicates with no more than a single instance of the same database.
CPU License (CP). End User may install and use each copy of the Software on a number of Servers up to the number indicated in the order
provided that the performance capacity of the Server(s) does not exceed the performance capacity specified for the Software. End User may
not reinstall or operate the Software on Server(s) with a larger performance capacity without Avaya’s prior consent and payment of an upgrade
fee.
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Named User License (NU). You may: (i) install and use the Software on a single Designated Processor or Server per authorized Named User
(defined below); or (ii) install and use the Software on a Server so long as only authorized Named Users access and use the Software. “Named
User”, means a user or device that has been expressly authorized by Avaya to access and use the Software. At Avaya’s sole discretion, a
“Named User” may be, without limitation, designated by name, corporate function (e.g., webmaster or helpdesk), an e-mail or voice mail
account in the name of a person or corporate function, or a directory entry in the administrative database utilized by the Software that permits
one user to interface with the Software.
Shrinkwrap License (SR). You may install and use the Software in accordance with the terms and conditions of the applicable license
agreements, such as “shrinkwrap” or “clickthrough” license accompanying or applicable to the Software (“Shrinkwrap License”).
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by Avaya as part of its purchase of the Nortel Enterprise Solutions Business
in December 2009. The Heritage Nortel Software currently available for license from Avaya is the software contained within the list of Heritage
Nortel Products located at http://support.avaya.com/LicenseInfo under the link “Heritage Nortel Products”. For Heritage Nortel Software, Avaya
grants Customer a license to use Heritage Nortel Software provided hereunder solely to the extent of the authorized activation or authorized
usage level, solely for the purpose specified in the Documentation, and solely as embedded in, for execution on, or (in the event the applicable
Documentation permits installation on non-Avaya equipment) for communication with Avaya equipment. Charges for Heritage Nortel Software
may be based on extent of activation or use authorized as specified in an order or invoice.
Copyright
Except where expressly stated otherwise, no use should be made of materials on this site, the Documentation, Software, or hardware provided
by Avaya. All content on this site, the documentation and the Product provided by Avaya including the selection, arrangement and design of
the content is owned either by Avaya or its licensors and is protected by copyright and other intellectual property laws including the sui generis
rights relating to the protection of databases. You may not modify, copy, reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
Each vAppliance will have its own ordering code. Note that each instance of a vAppliance must be separately ordered. If the end user
customer or Avaya channel partner would like to install two of the same type of vAppliances, then two vAppliances of that type must be
ordered.
Each Product has its own ordering code. Note that each instance of a Product must be separately licensed and ordered. “Instance” means one
unique copy of the Software. For example, if the end user customer or Avaya channel partner would like to install two instances of the same
type of Products, then two Products of that type must be ordered.
Third Party Components
“Third Party Components” mean certain software programs or portions thereof included in the Software that may contain software (including
open source software) distributed under third party agreements (“Third Party Components”), which contain terms regarding the rights to use
certain portions of the Software (“Third Party Terms”). Information regarding distributed Linux OS source code (for those Products that have
distributed Linux OS source code) and identifying the copyright holders of the Third Party Components and the Third Party Terms that apply is
available in the Documentation or on Avaya’s website at: http://support.avaya.com/Copyright. You agree to the Third Party Terms for any such
Third Party Components.
Note to Service Provider
The Product may use Third Party Components that have Third Party Terms that do not allow hosting and may need to be independently
licensed for such purpose.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can result in substantial additional charges for your telecommunications services.
Avaya Toll Fraud intervention
If you suspect that you are being victimized by Toll Fraud and you need technical assistance or support, call Technical Service Center Toll
Fraud Intervention Hotline at +1-800-643-2353 for the United States and Canada. For additional support telephone numbers, see the Avaya
Support website: http://support.avaya.com. Suspected security vulnerabilities with Avaya products should be reported to Avaya by sending
mail to: securityalerts@avaya.com.
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this site, the Documentation and Product(s) provided by Avaya are the
registered or unregistered Marks of Avaya, its affiliates, or other third parties. Users are not permitted to use such Marks without prior written
consent from Avaya or such third party which may own the Mark. Nothing contained in this site, the Documentation and Product(s) should be
construed as granting, by implication, estoppel, or otherwise, any license or right in and to the Marks without the express written permission of
Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
All non-Avaya trademarks are the property of their respective owners. Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Downloading Documentation
For the most current versions of Documentation, see the Avaya Support website: http://support.avaya.com.
Contact Avaya Support
See the Avaya Support website: http://support.avaya.com for product notices and articles, or to report a problem with your Avaya product. For
a list of support telephone numbers and contact addresses, go to the Avaya Support website: http://support.avaya.com, scroll to the bottom of
the page, and select Contact Avaya Support.
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Introduction:

1. Introduction
The Softphone from Avaya enables you to make voice and video phone calls using SIP-based standards.

Standard Telephone Features
The Avaya Softphone has all standard telephone features, including:
· Call display and Message Waiting Indicator (MWI)
· Speakerphone and Mute
· Redial, Hold, Do Not Disturb
· Call history – list of received, missed, and dialed calls
· Access to IP Office directory
· Call forward
· Call transfer
· Six-party audio conferencing
· Six-party video conferencing

Enhanced Features and Functions
The Softphone also supports the following features and functions:
· Video
· Support for several languages in addition to English: French, German, Italian, Portuguese, and Spanish.
· Contact list containing the individual user’s contacts
· Directory containing names from central and personal IP Office directory
· Automatic detection and configuration of audio and video devices
· Acoustic echo cancellation, automatic gain control, voice activity detection
· Support for DTMF (RFC 2833, inband DTMF or SIP INFO messages).
· Support for the following audio codecs: G.711, G.723.1, G.729a, G.722
· Support for the following video codecs: H.263, H.263+, H.264
· Compliance to 3261 SIP standard
· Support for these firewall traversal solutions: STUN, TURN, or ICE
· The Softphone includes an icon to indicate your do not disturb status. The icon can be clicked to change the status
· A Speed Dials tab is available. It contains buttons to which you can assign numbers to dial and name labels. For
buttons that match another extension number, the button color indicates when that user is busy
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1.1 Logging into Softphone
The Softphone Login window appears once the Softphone has been started.

1. Enter your user name, password and login server into the corresponding fields.
· Using Softphone with No Password
You can be configured to use Softphone without requiring a password. However, in that case the IM and
presence features do not work and display an error message if used.
2. Select the bandwidth profile for your network.
· Use the standard setting Default to let IP Office select the best available transmission rate.
· Select Low Bandwidth if you are working at a location where bandwidth is limited.
· Selected High Bandwidth only if you are sure that you are connected to a network with no bandwidth
limitation.
3. If you are the only person who uses the PC, you can use the Remember login information setting to have
Softphone remember the name and password.
4. Selecting the Login automatically option will allow you to skip the login process the next time you start the
Softphone. The logging in process is still displayed for a few seconds in order to allow you to interrupt it if
necessary.
5. Minimize to System Tray will do just that after the login has been completed successfully. Use this option if you
don't immediately intend to use Softphone but want it running and available.
6. Click Log in. The progress of the login is displayed and details of which audio devices the Softphone is using are
also shown.

Hot Desking with Softphone
If you normally work from a phone on the IP Office telephone system or are temporarily logged in at one, logging in to
Softphone will automatically log you off that phone and redirect your calls to your Softphone.
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Introduction: Logging into Softphone

1.2 The Softphone Windows
You can arrange the Softphone window to suit your needs, showing or hiding many of the controls.
Button/Icon

Description
· Online Status
This icon indicates your online status. For a list of status icons and their meanings, see Setting
your status 27 .

In Call Control
Buttons
·
These buttons appear below the dial pad when it is shown. To show or hide them select
Softphone > Preferences > Application > Display in-call buttons on the dialpad. By
default, these buttons are hidden.

/

· Allow Calls/Do Not Disturb
This icon, located on the right side of the panel, indicates whether you have do not disturb on or
off. Clicking on the icon makes a call to the IP Office phone system to change the current state.
When you have do not disturb on (
otherwise they receive busy.

), calls to you are redirected to your voicemail if available,

· Show/Hide the dial pad.
You can type numbers and names directly into the call entry field or you can show and use the
on screen dial pad.
· Show/Hide video
Click to show or hide the video window.
· Speaker/Headset mode
Switch between headset and PC speaker modes.
· Adjust speaker volume
· Mute/Unmute microphone
· Message waiting indicator
Click to access your voicemail mailbox. You need the dialpad visible in order to drive the mailbox
prompts.
· Missed call indicator
Click this icon to open the History tab and view a list of missed calls.
· Minimize to the system tray
Run the Softphone as an icon in your Windows system tray (normally bottom right of your
Windows desktop). To reopen Softphone double click on that icon.
· While minimized to the system tray, you can use the popup alerts to handle incoming calls.
Select Softphone > Preferences > Alerts & Sounds > Enable alert displays to switch
alerts on or off.
· Alternatively minimize the Softphone to the system tray if you want to use another IP Office
application such as the one-X Portal for IP Office to make and answer your calls.
· If you exit when the Softphone is minimized; the Softphone will start as minimized next time.
· Minimize to taskbar
Minimizes the Softphone to the Windows taskbar.

· View Menu Options
The view menu provides the following options:
· Select which tabs to show
Show or hide the Contacts 23 , History
tabs.
View Menu

·

28

, Directory

29

, Features

30

and Speed Dial

32

Detach/Reattach Tabs
When displayed, you can use these icons to select whether each tab appears as part of
the main windows or as a separately sizeable and positionable window.

· Always on Top
Set the Softphone to remain on top of other application windows.
· Zoom
Change the size of the text and controls used in the Softphone windows.
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Button/Icon

Description
· Message Archive
View you recent IM activity for any contact, group chat session, or chat room session.
· Chat Rooms
View the chat rooms that you belong to.

Close the
Softphone

· Close the Softphone
To close the Softphone select Softphone > Exit. You can also right-click on the tray icon and
select Exit to close the Softphone.
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Introduction: The Softphone Windows

1.3 Placing a Call
The simplest method to make a call is to enter the name or number into the call entry field. As you enter the name or
number, matches from your Contacts and History are shown and can be selected to complete the name or number. Once
started, the outgoing call opens in its own panel within the main Softphone window.
1. If necessary, click
in the call entry field to clear any previous entry, then enter the name or number of the
contact you wish to call.
2. Click Call to make the call. You can also click on the

down arrow icon and select Audio Call or Video Call.

You will hear a ringing tone while the Softphone attempts to make a connection.

Selecting a Contact
Aside from entering the name or number of the contact, there are many other ways to select a contact.

From the dialpad or computer keyboard
1. Enter the number or address in the call entry field using the dialpad or the computer keyboard.
As you type, a suggestion for completing the entry may appear. Choose the suggestion or keep typing.
2. Click the Call button or press Enter.

Dialing with the dialpad
1. If the dialpad is not visible, click the Show/Hide dialpad button.
2. Click the numbers on the dialpad to enter the phone number. Alternatively, enter the number or address in
the call entry field using the dialpad or the computer keyboard.
3. Click the Call button or press Enter.

Dragging-and-dropping a contact from the Contacts or History tab
· Drag an entry from the Contacts or History tab. If the tab contains lots of contacts, first search or filter the
list.

Right-clicking a contact from the Contacts or History tab
· Right-click an entry from the Contacts or History tab and choose Call. If the tab contains a lot of entries,
first search or filter the list.

Double-clicking a contact
· Double-click an entry from the Contacts tab. If the tab contains lots of contacts, first search or filter the list.

Double-clicking a previous call
· Drag an entry from the History tab. If the tab contains lots of contacts, first search or filter the list.

Redialing
1. When the call entry field is empty, click the Call button.
The last number dialed is shown.
2. Click Call again to call it. Alternatively, click the
down arrow in the call entry field and select a recent call.
Note: The Softphone can redial a call immediately if you select the option to "Call immediately when a
number is selected" in the Preferences > Application menu.

1.4 Placing Another Call
You can place a new call without hanging up on the current call.
1. Place a call 13 in the normal way. A second call panel appears below the existing call and the existing call is
automatically put on hold.
2. Switch between the different calls by clicking Resume on the desired call panel. That call becomes the active call
and all other calls are on hold.

1.5 Ending a Call
Click the End button on the call panel (the call can be active or on hold). The call panel closes after a few seconds.
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1.6 Handling an Incoming Call
As soon as an incoming call is received, a call panel appears, showing information about the call. In addition, call alert
boxes appear even if Softphone is minimized.
You can disable the call alert box through the Softphone preferences
Sounds panel.

Incoming call alert for audio
only.

34

available on the Preferences > Alerts &

Incoming call alert with video.

Answering a call
1. From the Call panel or Call Alert box, click Answer. You can also press Enter on the keyboard if the Softphone is
the active application. If you are on another call, that first call is automatically put on hold.
2. You are now talking to the new caller.

Forwarding a call
Select the Features tab to access the call forwarding feature. For information about how to program a Feature
button for call forwarding, see Features Tab 30 .

Declining a call
From the Call panel or Call Alert box, click Decline. The caller will receive a busy signal

Answering a video call
When you receive a video call, you may or may not want to include your own video.
· From the Call Alert box, click Video to answer using video (with audio) or click Audio to answer using audio only.
If you have a camera, you can add video later during the call by clicking the

button.

1.7 Auto Answer
Auto answer is initially configured to auto-answer after one ring, and to send only your audio when the call is established.
To change this configuration choose Softphone > Preferences > Call Automation 36 .
1. In the call panel click
down.

and select Auto Answer. Note: Auto answer is automatically turned off when you shut

1.8 Holding a Call
Click Hold. To take the call back off hold click Resume.

Softphone User Guide (Windows)
IP Office 9.0

Page 14
- Issue 07c (25 February 2014)

Introduction: Holding a Call

1.9 Transfering a Call
Basic (Unattended) Transfer – Transfer this Call
You can transfer a call to any number without first speaking to the other person.
1. While connected to the call that you want to transfer, click on the

transfer icon.

2. The call is put on hold. Below the call details enter the name or number for the transfer destination.
3. Click on Transfer Now. A call is placed to the transfer destination.
4. To complete the transfer without waiting for the call to be answered click on End.

Attended Transfer – Call then Transfer
You can first speak to the target (the person you are transferring the call to).
1. While connected to the call that you want to transfer, click on the

transfer icon.

2. The call is put on hold. Below the call details enter the name or number for the transfer destination.
3. Click on Call. A call is placed to the transfer destination.
4. If the call is not answered or the transfer destination doesn't want the call, click Resume to return to the held call.
To complete the transfer click Transfer Now.

1.10 Shutting Down
There are many ways to shut down the Softphone
1. Select Softphone > Exit or press Ctrl-Q.
2. Alternatively, you can right-click on the tray icon and select Exit to shut down the Softphone.
· Note: Clicking the
exit the Softphone.

icon on the softphone title bar minimizes the Softphone to the system tray; it does not

1.11 Accessing Voicemail
1. Click the
icon to automatically connect to voicemail and listen to your messages. You will need to have the
dialpad visible in order to move around the mailbox options.
2. Click on the

Dialpad icon if the dialpad is not already displayed.
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1.12 Handling a Video Call
Placing a Video Call
You can start a call with video by either the dialpad, entering the number or address of the contact, or by right-clicking in
the Contacts or History tab.

Dialing with the dialpad
1. If the dialpad is not visible, click the Show/Hide dialpad button.
2. Click the numbers on the dialpad to enter the phone number. Alternatively, enter the number or address in
the call entry field using the dialpad or the computer keyboard. A suggestion for completing the entry may
appear. Choose the suggestion or keep typing.
3. Click the

arrow beside the Call button and choose Video call.

Right-clicking a contact from the Contacts or History tab
1. Right-click an entry from the Contacts or History tab and choose Video Call. If the tab contains a lot of
entries, first search or filter the list.

Adding Video
It is only possible to add video if you have a camera.

1. Click
Start Video to add video to an established call.
When you add video, the other party may (or may not) start sending their video to you.
2. Pause or stop the video at any time.

Receiving Video
If the other party starts their video, your video window automatically opens and the video is played.

1. To begin sending your video, click

Start Video (assuming you have a camera).

2. Pause or stop the video at any time.

Pausing and Resuming Video
1. Click

Stop Video or close the video window to pause sending your video.

2. Click

Start Video to resume sending your video; the video window will open.

3. Click

to show or hide your video window (this does not stop the video).

Grandstream Users
If you use Grandstream, or if the person with whom you wish to have a video call uses Grandstream, ensure that all
participants in the video call switch to video codec H.264. Participants who do not switch codecs will be able to send and
see their own video, but the intended recipient(s) will not see anything due to a codec negotiation error. See the section
on Video Codecs 36 for more information.
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Introduction: Handling a Video Call

1.13 Forwarding a Call
You can forward (transfer) an incoming call:
· Click the
Call Forward icon on the call panel. You will be prompted to enter the name or number of the
contact receiving the forwarded call.

1.14 Recording a Call
Click

and select Start Call Recording.
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1.15 Conference Calls
Starting a Conference Call
You can conference separate calls together once each call is established
· In the current Call panel, click on

13

.

and select Merge Calls. All of the established calls will be merged.

Alternatively, you can click on the
button if it is shown on the In Call Control Buttons panel. To view this
button, refer to The Softphone Windows 11 section of this document.

Starting a Video Conference Call
Calls made with the IP Office Softphone will work without a video camera, but a video camera is necessary to allow other
parties to see your video image. The IP Office Softphone will work with most USB video cameras.
To begin, ensure that all the participants you invite to the conference are sending video prior to merging their calls.
· Click on
and select Merge Calls, or click on the
button.
Note: After the conference is established, participants may have to resend their video. When participants are
removed from "Hold" or new participants join the conference, each participant must resend their video when the
conference session continues.
The following image illustrates a typical video conference call (one that includes five participants). Note how you can
change the size of the video window to manipulate the position of each participant's video feed by clicking and dragging
the
icon on the lower right corner of the video display.

Including Video in a Conference
When you start a conference from established calls, video is automatically included if at least one of the calls already
includes video and is sent to all the participants.
When you start an audio conference from scratch, video is not included. Once you begin an audio conference, you cannot
change the conference into a video conference.

How Video is Shared
The conference host (the person who starts the conference) serves as the host for other video. Whatever the conference
host is receiving will automatically be sent to the other parties. If the conference host pauses or stops video, the other
participants will no longer receive video. As such, in the event that you experience video errors, request that the
conference host reestablish video to all parties by disabling and re-enabling video.
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Introduction: Conference Calls

1.16 Instant Messaging
You can send an Instant Message (IM) to a contact who has a softphone or XMPP address, but you must be connected to
one-X Portal. The Softphone allows you to send IMs to individuals or broadcast groups, and also supports IM
conferencing and chat rooms (including ad-hoc group chat). In addition, you can send files to any user who has an XMPP
address.
· Using Softphone with No Password
You can be configured to use Softphone without requiring a password. However, in that case the IM and
presence features do not work and display an error message if used.

Sending an IM
1. From the Contacts tab, right-click on the contact and choose Send Instant Message. The contact must have a
softphone address. Alternately, click on the IM icon that appears to the right of the contact name.
2. Type the message, including any emoticons and formatting that you wish. To insert a return in the message, press
Enter. (You can control the behaviour of Enter and of Ctrl-Enter on the Softphone > Preferences > Application
panel.)
3. Click Send.
· Note: If the status of the recipient is set to Do Not Disturb, the message will not be received.

Receiving an IM
When you receive an IM, either the IM window, or a Call Alert displays without opening the IM window. You can choose
which window displays using the Preferences > Alerts & Sounds > Alerts panel.

Sending a Broadcast IM
You can send an IM to several people at one time. A broadcast IM is different than a group chat:
· With a broadcast IM, each recipient can reply to the IM, but only the sender will see these replies; the other
recipients will not see these replies.
· With a group chat, the messages that each participant sends are seen by all participants.
1. Select the parties from the Contacts tab in one of the following ways:
· Select one or more contacts in the usual ways (using Shift-click or Ctrl-click and/or Shift+Ctrl+click).
· Select one or more groups in the usual way.
2. Right-click and choose Broadcast IM. The Broadcast Instant Message window appears.
3. Type the message including any emoticons and formatting that you wish. To insert a return in the message, press
Enter. (You can control the behaviour of Enter and of Ctrl-Enter on the Softphone > Preferences > Application
panel.)
4. Press Send or Enter. The IM is sent and the window remains open. If a recipient sends you a response, the
response will display in your regular Instant Message window; you will then be in a regular IM exchange with that
one individual.

Sending a Broadcast IM to 'everyone'
You can send a broadcast IM to everyone in the system using the 'everyone' contact located under the "Broadcast
Groups" group.
1. In the Contacts tab, right-click 'everyone' and select Send Instant Message.
2. Type your message and press Send or Enter. The message is sent to all contacts in the system group.
Alternatively, you can use the process outlined in "Sending a Broadcast IM" to right-click on the system group and send a
broadcast IM to all the users in the system. The difference is that you have the option to selectively remove individual
users, which is not possible with the 'everyone' broadcast method.
When you receive a broadcast message from 'everyone,' the sender is indicated in square brackets but you will not be
able to reply. Any attempt to reply is met with the error message "Replies to broadcast messages are not allowed."

Starting a Group Chat (ad-hoc conference IM)
Softphone's ad-hoc Group Chat feature allows you to exchange instant messages with a group of people in a session that
is created on the fly (to participate in a chat session that is not ad-hoc, see Chat Rooms below).
All people in a group chat must have XMPP accounts configured in order to participate in the session. There is no limit to
the number of participants in a group chat session, and you can invite more participants during the session.
1. In the Contacts tab, select the desired online contacts.
2. Right-click the last selected contact and choose Start Group Chat. The invitation dialog appears.
3. Enter your invitation text and click Invite.

Softphone User Guide (Windows)
IP Office 9.0

Page 19
- Issue 07c (25 February 2014)

4. To invite additional participants to a group chat, select online contacts (who have XMPP addresses) from your
Contact List and drag them to the Group Chat window. Any participant in the group chat can invite more
participants.
Note: You cannot start a group chat with the 'everyone' contact because it is a special user. If you right click
'everyone' and select Start Group Chat, nothing will happen.

Leaving a Group Chat
When you leave an ad-hoc group chat, the session continues with the remaining participants.
· Close the Group Chat window. Note: You will not be able to rejoin the group chat unless you are re-invited.

Chat Rooms
Chat rooms are set up to allow the same groups of people to have regular and recurring group IM sessions. For example,
your system administrator may create a chat room called "Marketing" and add the marketing staff as members. Every
Monday at 8:00 a.m., each member opens the chat room on the IP Office Softphone and joins the "Marketing"
conference.

Joining a Chat Room
Chat rooms are unlike group chat sessions in that they are not ad-hoc. So, unlike group chat sessions, you are able to
view a list of available chat rooms via the View menu.
1. Obtain the names of the chat rooms you wish to enter from your system administrator.
2. Select View > Chat Rooms. If the menu item does not display, make sure that the appropriate XMPP account is
enabled. If you have more than one XMPP account, an account prompt appears.
3. Select the appropriate account and click OK. The group chat appears on this list until the last person leaves.
4. Select the chat room and click Join Conference. The Chat Room
window displays, listing the participants who have joined the chat room session.

Rejoining a Chat Room
If you leave a chat room, you can rejoin it using the procedure above.

Viewing the IM Message Archive
You can view your recent IM activity for any contact, group chat session, or chat room session. Do one of the following:
· On the menu, click View > Message Archive.
· Select your own name to view your group chat and chat room sessions.
· Select another person to view instant message exchanges with that person.
· Select one or more names and then right-click to save or delete all conversations with the selected
people.
· Select a conversation and right-click to delete or save the selected conversation.
· Right-click a contact and choose View Message Archive.

Sending and Receiving Files
If you have an XMPP account, you can send files to another contact who has also has an XMPP account. You can also
receive files from a contact who has an XMPP account.

Sending Files
Choose one of the following options:
· Right-click a contact and choose Send Files. A standard Open dialog box displays. Select the files to send and
click Open. The Send Files dialog displays a status message to show the progress of the file transfer.
· Drag a file from a folder to the IM window.
To cancel the file transfer before the other person retrieves the files, click Cancel.

Receiving Files
When you receive files from another person, a File Transfer dialog box displays. Choose one of the following options:
· Click Save to accept the file transfer and select the location where you want to save the file.
· Click Decline if you do not want to receive the file transfer.
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Chapter 2.
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2. Dialing Tabs
There are a set of tabs that can be displayed either as part of the main Softphone display, or as separate floating
windows.
The tabs are:
· Contacts 23
A directory of contacts stored by Softphone.
· History 28
Details of your calls made, received and missed while Softphone is running.
· Directory 29
A directory of contacts supplied by the IP Office telephone system.
· Features 30
A set of clickable buttons (up to 30) each of which can be assigned to a specific IP Office feature.
· Speed Dial 32
A set of clickable buttons (up to 60) which can be used to fast dial preset numbers.

Detaching a Tab
1. Select the tab.
2. Click on the
icon. The tab is changed to be a separate floating window which you can move, resize and position
separately from the main Softphone window.

Reattaching a Tab
1. Click on the

icon at the top right of the floating window.

Showing/Hiding the Tabs
The set of tabs can be hidden when not required. This option affects all the tabs and includes tabs that have been
detached.
· To change the current status (shown or hidden), select View and then choose one of the following options: Show
Contacts, Show History, Show Directory, Show Features, or Show Speed Dial.
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Dialing Tabs:

2.1 Contacts Tab
The Contacts tab displays your contacts and lets you specify multiple contact methods for them, including:
· Softphone address
· Home phone number, business phone number, mobile phone number.
Contacts are typically organized into groups. The Softphone includes built-in groups: Broadcast Groups, Family, Friends,
system, and Work. You can add more groups by specifying a new group name when you add or edit a contact.
From the Contacts tab, you can perform the following actions:
·

Add a contact
Select this option to add a new contact.

·

View Details of a Contact
Click on a contact to view the full details of that contact and select to see your call history filtered around calls to
or from the contact or select to edit the contact.

·

Call a Contact
Double-click on the contact to make a call.

·
When the contacts are shown in their groups, you can use the
collapse that group.

arrow icon next to each group to expand or

You can also right-click on a contact to select additional options for that contact. The following options are available:
·

Call

·

Video Call

·

Send Instant Message

·

Start Group Chat

·

Send Files

·

Edit a Contact

·

View Call history

·

View Message Archive

·

Add to Alert List

·

Split Contact

·

Delete Contact

Note: The contacts are not identical to the personnel directory on IP Office. Access to IP Office personnel directory on
softphone is possible through the Directory 29 tab but it is not possible, to edit this directory from IP Office. However, if
used in application mode with one-X Portal for IP Office as the front end, full editing of personal directory is possible.
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2.1.1 Managing Contacts and Groups
2.1.1.1 Adding a Contact
Click

or right-click a group and choose Add Contact to Group. The Contact Profile dialog appears.

Field

Description

Contact

Only the "Display name" is required. This is the name that will appear in the call panel and the Call Alert
when this person phones you.
You can specify the contact method on the right side of the screen. Select a method from the drop-down
menu and enter the contact information. You must enter at least one contact method. Enter as many
contact methods as you want. Softphone entries and e-mail entries must have the format
<name>@<domain>.

Group

Click to show the list of groups and check each group to add this contact to.

Primary
presence

This field displays only when the contact has more than one Softphone number or Instant Message
address. The primary presence is used as follows:
· The presence icon on the contact list shows the online status for this address.
· The single-click and double-click actions for instant messaging use this address.
You can still send IMs to this person at their other addresses, but you must right-click and choose from
the context menu.

Primary
phone
number

If the contact has more than one number, select the primary number. This number is used with
single-click and double-click calling.

2.1.1.2 Adding a Contact using an Existing Address
1. You can add a contact by capturing existing information:
· If you are on a phone call with a person who is not a contact, click the Add to Contacts button in the call
panel.
· On the History tab, select an entry that is not a contact. Right-click and choose Add as Contact.
2. The Contact Profile dialog appears. Complete the dialog as desired and press OK.

2.1.1.3 Importing Contacts
You can populate the Softphone contact list by importing from an external file or files. The new contacts will be added to
the existing contacts.
You can import a contact list from:
· A comma-separated file. Use this method to import from a Microsoft Excel file. You will first have to set up the file;
see below.
· A vCard file (*.vcf file). A vCard is an electronic business card that is often attached to an e-mail.

1. From the main menu, click the Contacts menu and choose Import Contacts. The Import Contacts wizard
starts.
2. As soon as you click Finish on the wizard, the Contacts tab in the Softphone is updated to show the imported
entries.

Setting up an Excel File for Import
1. Remove any introductory text or headings from the top of the file. (You can keep text at the end of the file; it will
be ignored during the import.)
2. Insert a blank row as the first row, then insert the headings that the Softphone will use to interpret the meaning of
each column. The columns can be in any order. The most popular headings are:
· display-name
· entry_id
· given_name
· surname
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Dialing Tabs: Contacts Tab
· postal_address
3. Save the file as *.csv.

2.1.1.4 Exporting Contacts
You can export a contact list to a comma-separated file or a vcf file.
1. From the main menu, click the Contacts menu and choose Export Contacts. The Export Contacts wizard
starts.
2. When you click Next, the export begins. A new file of the specified type is created.

2.1.1.5 Changing Contact Information
To change the information for a contact, right-click the contact and choose Edit Profile.

2.1.1.6 Moving or Deleting a Contact
· To drag one or more contacts to a different group, select them and drag to the title bar of the new group.
· To delete one or more contacts, select them, right-click, and choose Delete Contact or Delete Selected. The
contacts are removed from this group. If a contact belongs to several groups, it is removed from all groups.
Note: The System group is configured on the IP Office server and is populated on your softphone each time that you log
in (and only users with valid XMPP accounts appear in the System group). If you move or delete contacts from the
System group, the contact is restored to the System group when you log in again. To include a contact in a group other
than the System group, right-click the contact and select Edit Profile to display the Contact Profile screen. Select an
additional group from the Group menu and click OK.

2.1.1.7 Managing Groups
Adding a Group
Select any group, right-click, and choose Add New Group.

Deleting a Group
Select any group, right-click, and choose Delete Group.

Renaming a Group
Select any group, right-click, and choose Rename Group.
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2.1.2 Calling a Contact
To phone the person:

· Double-click the contact to start a phone call
· Right-click and choose Call. If necessary, click the desired number.
· Drag the contact to the call entry field to start a phone call.

Using the Contact Flyout
· Click a contact to show the Contact flyout. This flyout shows all the contact methods set up for the contact. You
can click a contact method to perform its action.

2.1.3 About My Buddy
My Buddy is a notification and command interface that can be used in conjunction with any XMPP-based messaging client.
The user ‘mybuddy’ should appear in your System contacts list and will assist you with many softphone tasks.

Viewing the commands available through My Buddy
1. Begin an IM session with ‘mybuddy’ (right-click, Start Group Chat).
2. In the IM window, type ‘help’ and press Enter. My Buddy replies with a list of available commands. To view
information about each command, type ‘help’ followed by the command name and press Enter.

Enabling a particular command
1. Begin an IM session with ‘mybuddy.’
2. In the IM window, type the command name, followed by the name or extension of the person you wish to perform
the command on, and press Enter. Some commands will work on their own, but other factors might be
extenuating (for example, the command ‘lock’ requires you to be hosting a conference).
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2.1.4 Sharing Online Status
You can publish your online status to contacts who have a softphone address, and you can set up the IP Office Softphone
to view the online status of other contacts.

Presence and Status Information
To watch a contact’s status, that contact must be tagged for presence:
· If you create a contact through the Contact Profile, the softphone automatically obtains status information if
the contact has a valid XMPP address.
· If you create a contacts through the Contact Profile and you include an XMPP address, you can click the
Enable XMPP Presence button to obtain status information for this address.
· If you create contacts by importing a contact list, you can specify during the import whether you want to
share presence information. See Importing Contacts 24 .

Setting your status
Click the down arrow beside the online status indicator on the Softphone and select the desired online status. The table
below lists the status indicators.
Indicator
Available

Your Status
Either:

Others' Status
You can contact this person.

· You have set your status to this value.
· The softphone has determined that you are logged on
but not on the phone or idle.
When you have this status, the softphone will
automatically detect when you are idle or on the phone,
and change the status to match. For more information
about the On the Phone or Idle statuses, see the
descriptions below.
Busy

You have set your status to this value. the softphone does
not automatically switch you out of this status; you must
switch yourself.

You can contact this person.

Away

You have set your status to this value. The softphone
does not automatically switch you out of this status; you
must switch yourself.

You can contact this person.

Either:

You can contact this person.

On the phone

· You have set your status to this value. In this case, the
softphone will never automatically switch you out of this
status; you must switch yourself.
· You started a phone call when your status was
“Available”. When your call finishes, your status reverts
to “Available”.
Not available for
calls

You have set your status to this value. The softphone
does not automatically switch you out of this status; you
must switch yourself.

You can contact this person, but
do not expect a reply.

Do not disturb

You have set your status to this value. The softphone
does not automatically switch you out of this status; you
must switch yourself.

You can call this person, but you
cannot send IMs.

You cannot select this status. This status displays
automatically if you have not moved or clicked the mouse
or pressed a keyboard key for the Idle period. To set the
Idle period see Softphone > Preferences > Application
.

You can contact this person.

Idle

As soon as you click the mouse or keyboard, your status
changes to “Available”.
Appear offline

You have set your status to this value. The other person
sees you as offline, even though you are actually online.
The other person cannot tell the difference between this
status and you really being offline.
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Indicator

Your Status

No icon

Others' Status

Not applicable

You are not watching the other
person’s status.

Customizing your status
You can create a custom status indicator.
1. Click the down arrow beside the status indicator, and double-click on one of the existing indicators.
2. Type your custom status.

Adding Contacts to the Alert List
You can add a contact to the Alert List in order to request to be notified when the online status of a contact changes.
Right-click the contact or contacts and choose Add to Alert List. The Alert List icon appears beside the contact.
When the contact’s status changes, a notification displays. Choose one of the following options:
· Click the phone icon or the IM icon on the notification window to call or IM the contact.
· Select the Keep contact on Alert List checkbox to continue receiving notifications of status changes for this
contact. If you do not select the checkbox, you will not receive further notifications.

2.2 History Tab
The History tab shows a record of calls that have occurred while Softphone is running.
You can right-click on an entry in the list to:
· Place a call
· Place a video call
· Add the person as contact
· Delete the call from history
· Delete all calls from history
Click on the

icon to select the type of call records to display in the call history.

· All
All calls of the various types listed below.
·

Received
Incoming calls that you have answered using Softphone.

·

Dialed
Outgoing calls you have made using Softphone.

·

Missed
Incoming calls that have alerted your Softphone but were not answered using Softphone.
· The
icon appears in the main Softphone window to show when there are missed calls in the call history. It
also shows the number of missed calls. Clicking on the icon will display the History tab.

Note: Contacts are only recorded when the softphone is running. Calls received when the softphone is not active will not
be shown.
If Softphone is used in combination with one-X Portal for IP Office as the front end, the call log functionality of one-X
Portal for IP Office can be used that will record all incoming calls including those received when the softphone is not
active.

Phoning from History
You can either:
1. Right-click on an entry to place a call to this person, using the contact method that was used for this call. You can
double-click to place an audio call.
or
2. Place a call to this person and add them to a conference call that is in progress.
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2.3 The Directory Tab
The Directory tab links directly to your local IP Office. Your directory will contain contact entries from the following IP
Office contact stores: local IP Office directory, local IP Office Small Community network numbers, Local & IP Office Small
Community Network Hunt Groups, Private user Directory.

Searching for a Contact
The search box is context sensitive and allows you to search by name or by number.
1. Start typing in the search box and the displayed list of contacts will automatically start to narrow down based on
your input.
2. You can clear the Search Box by clicking the ‘X’ displayed at the far right of the Search Box.

Phoning a Person
You can phone a person directly from the Directory.
1. Right-click a directory entry and choose Call or Video Call.
A new call panel will appear and the call is placed immediately.

Creating a Contact
1. Right-click an entry and choose Add as Contact.
The contact profile window appears, populated with all the information from the IP Office directories.
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2. Complete the window with any missing information that you want to record and press OK. The contact will now be
listed on your Contact tab.

Note: While it is possible to access the centralized private directory on IP Office, it is not possible to change the
directory on IP Office from Softphone. Please change it from your desktop phone or one-X Portal for IP Office.

2.4 Features Tab
The Features tab allows you to access a set of button which can be used to control various IP Office call features.

Configuring a Feature Button
1. To configure a button, right-click on the button and select Edit. A menu with the button options appears.

2. To use one of the existing IP Office features, select Predefined and select the required feature from the drop
down feature list.

3. To use a custom feature, select Custom. Enter the label and feature code manually.
4. Click Assign.

Displaying More Buttons
1. Right click on the page and select Show rows.
2. Select the number of rows of buttons to be displayed on the tab.

Supported Features
·
·
·
·
·

Call
Call
Call
Call
Call

Park
Pickup Any
Pickup Group
Pickup Members
Queue
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·
·
·
·
·

Do Not Disturb Off
Do Not Disturb Exception Add
Do Not Disturb Exception Del
Forward on Busy Number
Forward Unconditional On

·
·
·
·
·

Follow Me To
Fwd Huntgroup Calls On
Fwd Huntgroup Calls Off
Hold Music
Set Hunt Group Night Service
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·
·
·
·
·
·
·

Call Record
Call Steal
Cancel All Forwarding
Clear Hunt Group Night Service
Conference Add
Directed Pickup
Do Not Disturb On
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·
·
·
·
·
·
·

Forward Unconditional Off
Forward On Busy On
Forward On Busy Off
Forward On No Answer On
Forward On No Answer Off
Forward Number
Follow Me Here

·
·
·
·
·
·

Relay On
Relay Off
Relay Pulse
Unpark
Voicemail On
Voicemail Off
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2.5 Speed Dial Tab
The Speed Dial tab allows you to create a set of buttons for numbers you want to dial in a single click. You can set a
text label for each button, and you can choose whether to view the status of the extensions that you add.

Configuring a Speed Dial Button
1. To configure a button, right-click on the button and select Edit.
2. Enter a name and number for the contact.
3. If you select Show status, the button will indicate the busy status of the number if it matches an internal
extension.
When you select Show status, you will see a visual indicator of the status. You can also choose to receive an audio
notification when there is an incoming call to an extension that you are monitoring. This feature is useful if you
need to monitor calls to other extensions and answer them if the user at that extension is not available. For more
information, see Alerts & Sounds 34 .
4. Click OK.

Displaying More Buttons
1. Right click on the page and select Show rows.
2. Select the number of rows of buttons to be displayed on the tab.
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3. Configuring Preferences
Choose Softphone > Preferences. The Preferences window appears. The Preferences panels let you control the way
that you work with the Softphone.

3.1 Application
The Application panel lets you set your preferences for general GUI behavior and lets you set up for login.
Section

Description

General
Preferences

Allows you to configure language options as well as startup, logging, and calling settings.

Messages &
Presence

Allows you to configure the idle time (the time it takes before Idle status is assumed) as well as
other messaging settings.

Default Actions

Allows you to configure the default behaviour of various buttons and actions.

3.2 Alerts & Sounds
This panel lets you choose how you will be notified of events on your IP Office Softphone.
Tab

Description

Alerts

On the Alerts tab, you can enable a call alert dialog box. The call alert box is a small menu that is
displayed when an incoming call arrives.

Sounds

You can use the Sounds tab to also enable audio notifications for different call scenarios. These
notifications can be default sounds provided by Softphone, or you can select a sound file that you
want used for each scenario.
You can also choose to receive an audio notification when there is an incoming call to an
extension that you are monitoring. This feature is useful if you need to monitor calls to other
extensions and answer them if the user at that extension is not available. The options are:
Select For incoming call on a monitored endpoint in Workgroup to receive an audio notification
when there is an incoming call to an extension that you are monitoring. Select For incoming call
on a monitored endpoint in Workgroup (busy) to receive an audio notification when there is an
incoming call to an extension that you are monitoring while you are in a call.
You can monitor an extension by configuring it on a speed dial button and selecting Show Status.
For information about how to configure a speed dial button, see Speed Dial Tab 32 .
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3.3 Devices
The Softphone automatically detects devices at each startup and selects the most appropriate device for each purpose. If
you do not like this selection, you can override it on this panel. If you override a selection, it will apply the next time you
start the softphone, unless the device is no longer available, in which case the softphone will again automatically select
the device to use.
When Zero-touch device configuration is enabled, the Softphone will automatically detect the new device and start
using it whenever you change your audio or video device.

Device Preferences
Tab

Description

Headset/Speakerphone You can select the desired audio configurations, such as speaker, speakerphone,
Mode
microphone, and HID Device settings.
Other Devices

You can select other devices that may be available for audio output. You can select the
camera device as well.

Switching Between Multiple Devices
If you have more than one device available at the same time and you wish to change from one device to another, you
will need to do the following:
1. Restart the application.
2. Go to Softphone > Preferences and select the desired headset/speakerphone under the Devices tab.
3. Go to Help > Troubleshoot and select the audio device you wish to use under the Devices tab.
4. Restart the application. If you continue to have problems, disable Zero-touch device configuration and try the
procedure again.

3.3.1 HID Devices: USB Device Button Setup
You can assign functions to a HID-compliant device. The table below outlines the steps required to assign functions to
USB device buttons.
Step

Description

1.

· Select the type of function you want to assign to a device button. You will choose which button
shortly. Use the drop down arrow to select the function from a list. You can click Cancel at any time.

2.

· Enter a customized description that is clear and easy to identify.

3.

· Click in the "Button mapping" field and then click the button you want assigned. For example, you can
set "the green button" so that it answers an incoming call. So long as your device is HID-compliant,
you can click Add and the mapping will appear in the table. If you are unhappy with a mapping you
can select it and click Remove to remove that mapping and free the device button.
· Click OK when you are satisfied with the device mapping.

3.4 Shortcut Keys
This menu allows you to select whether you want to use shortcut key combinations for certain actions and to edit what
those key combinations are. When you click the Enable shortcut keys checkbox, the shortcut key table below will be
visible. Enable the checkboxes to enable the shortcut. You can also customize shortcuts via the Edit button. Some
examples below:
Action

Key Combination

Answer call

CTRL+SHIFT+ALT+A

Hang up call

CTRL+SHIFT+ALT+H

Focus Softphone

CTRL+SHIFT+ALT+F

Toggle mute

CTRL+SHIFT+ALT+M

Redial

CTRL+SHIFT+ALT+R
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3.5 Video Codecs
Video codecs describe the format by which video streams are compressed for transmission over networks. Some codecs
require less bandwidth than others, but may result in lower video quality. Change the settings on this tab only if advised
to do so by your system administrator.

With only one codec enabled, all calls made will use that particular compression format. With more than one codec
enabled, the Softphone automatically chooses the best codec based on the other party’s capability, the available
bandwidth, and network conditions.
Note that it is not possible to set a 'preferred' video codec, nor does IP Office negotiate one.

3.6 Media Quality
These settings are used to adjust the Softphone's video and audio operation.
Tab

Description

Audio Quality You can select which volume controls are used in relation to Microsoft Windows master volume control.
You can also select or deselect options to reduce echoes and background noise, as well as enable
automatic gain control.
Video Quality You can enable the option to correct upside-down video displays as well as resolution settings. Enable
the Disable HD video checkbox and you can switch from standard video to either high or low
resolution video, or even HD widescreen. However, note that higher resolutions require more
bandwidth.

3.7 Call Automation
These settings let you configure how you want auto answer to handle incoming calls, when Auto Answer is enabled.
Section

Description

Auto Answer Calls

Use the settings in the Auto Answer Calls area when you have selected auto answer 14 in
the Softphone call panel. You can select the time required before an auto answer occurs, as
well as you can select whether to use audio or video by default when answering a call.

Third-party Call
Automation

The Third-party Call Automation feature controls how the softphone handles external
auto-answer requests. Ensure that this option is set to Auto-answer with audio-only.
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Configuring Preferences: Call Automation

3.8 Troubleshooting
The Softphone includes three tools for helping you troubleshoot problems:
· You can verify that your microphone, speakers and camera are working and can set the volume to a comfortable
level without having to actually place a phone call.
· You can verify that you are successfully connected to the network.
· While you are on a phone call, you can test the quality of the audio. Note that to perform a valid test, you should
be on an established call (not a call attempt). Audio quality is dependent on several parameters that Softphone
can not completely influence. When troubleshooting, take the following parameters into account:

Network quality
If audio problems occur, try to select the "Low Bandwidth" setting when logging into the Softphone. The softphone will
then use bandwidth efficient transmission of audio streams.
If using Video, select a lower video resolution in Softphone > Preferences > Media Quality tab. Also, try to use the
H.264 Codec instead of H.263 if possible (for settings please see Media Quality 36 and Video Codecs 36 ).

Competing processes and resources
While every possible attempt has been taken to give Softphone priority over other applications, there is a chance that
those applications, e.g. Virus scan software, can impact performance from the softphone, The following actions can be
taken:
1. Close unused applications to e.g. avoid memory swapping.
2. Postpone activities like virus scans to a time when Softphone is not needed.
3. Use a single screen PC, not dual monitor if possible.
4. Parallel usage of other communication tools, for example NetMeeting, for application sharing can impact
voice-quality, especially if used with a low-bandwidth network. If audio quality issues appear, refrain from using
other communication applications.

Known Issue
If you select menus or click on contacts and the dropdown/pullout menu is not visible (it appears behind the main
Softphone panel instead of in front of it), do not be concerned. Softphone itself is not experiencing a problem. This is
known to occur with lower-end graphics chipsets and outdated graphics drivers. Updating your drivers and/or upgrading
to Windows 7 should resolve this problem completely. The only workaround for this issue is to reboot the PC.

Softphone User Guide (Windows)
IP Office 9.0

Page 37
- Issue 07c (25 February 2014)

Chapter 4.
Document History

Softphone User Guide (Windows)
IP Office 9.0

Page 39
- Issue 07c (25 February 2014)

4. Document History
Date

Issue

Changes

25th February 2014

07c

· General layout tidy.
· Added list of supported Features

Softphone User Guide (Windows)
IP Office 9.0

30

tab button options.

Page 40
- Issue 07c (25 February 2014)

Index

Index
A
Add
Contact 24
Contact from history 28
Group 25
Add as Contact
From directory 29
From history 28
Add to Contacts
During a call 24
Alert
Sounds 34
Alerts & Sounds 34
Answer 14
Auto Answer 14, 36
Application 34
Attended Transfer 15
Audio quality 37
Audior 14
Auto Answer 14, 36
Auto launch 34
Automatic device selection 35
Automatic login
Delay 34
Automation 36

B

E
Edit Profile 25
Enable Alert Displays 34
Enable sounds 34
End a call 13
Excel 24
Exchange 24
Export
Contacts 25

F
Features 30
Forward 14
Forwarding Calls 17

G
G.711 9
G.723.1 9
G.729a 9
Group
Add 25
Delete 25
Rename 25

H

Bandwidth profile 10
Button features 30
Button Setup 35

C
Call
Answer 14
Attended transfer
Conference 18
Decline 14
End 13
Forward 14, 17
Make 13
Transfer 15
Video 16
Call Automation 36
Call Log 28
Camera 35
Codecs 36
Conference Calls 18
Contact
Add 24
Delete 25
Edit 25
Move 25
Profile 24
Contacts 23
Export 25
Import 24
Ungrouped 25

Device Setup 35
Devices 35
Dial pad
Hide 11
Directory 29
Drop 13

15

D
Decline 14
Delay automatic login 34
Delete
Contact 25
Group 25
History 28
Device selection 35
Softphone User Guide (Windows)
IP Office 9.0

H.263 9, 36
H.264 9, 36
Hangup 13
Headset Mode 35
HID Device 35
HID-Compliant device 35
Hide 11
High resolution 36
History 28

I
ICE 9
Image Quality 36
Import Contacts 24

L
Language 34
Log 28
Login
Delay 34
Login automatically
Low resolution 36

10

M
Mailbox 15
Make a call 13
Messages 15
Microphone 35
Microsoft Exchange 24
Microsoft Outlook 24, 25
Minimize 11
Move
Contact 25

N
Network quality 37

O
Outlook 24, 25

Page 41
- Issue 07c (25 February 2014)

P
Phone Ring Device 35
Preferences
Alerts & Sounds 34
Application 34
Call Automation 36
Devices 35
Network 36
Video codecs 36
Profile
Bandwidth 10
Edit 25
Programmable buttons 30

Q
Quality 37

R
Recording folder 34
Rename
Group 25
Resolution 36
Resume 13
RFC 2833 9
Ring PC speaker 35
Ringer
Volume 35

S
Show 11
Softphone Login 10
Speaker 35
Speakerphone Mode 35
Start automatically 34
Start Video 16
Stop Video 16
STUN 9
Supervised transfer 15

T
Test Devices 35
Transfer
Attended 15
TURN 9

U
Ungrouped Contacts 25
USB Device Button Setup 35

V
Video 14
Call 16
Video codecs 36
Video Image Quality 36
Voicemail 15
Volume
Ringer 35

Z
Zero-touch device configuration 35

Softphone User Guide (Windows)
IP Office 9.0

Page 42
- Issue 07c (25 February 2014)

Softphone User Guide (Windows)
IP Office 9.0

Page 43
- Issue 07c (25 February 2014)

Performance figures and data quoted in this document are typical, and must be
specifically confirmed in writing by Avaya before they become applicable to any
particular order or contract. The company reserves the right to make alterations
or amendments to the detailed specifications at its discretion. The publication of
information in this document does not imply freedom from patent or other
protective rights of Avaya or others.
All trademarks identified by the ® or ™ are registered trademarks or trademarks,
respectively, of Avaya Inc. All other trademarks are the property of their
respective owners.
This document contains proprietary information of Avaya and is not to be
disclosed or used except in accordance with applicable agreements.
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